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i-View User Guide 

1. Introduction 
i-View is a utility program for managing a network of Ishida scales. 

The principal functions of the software are as follows 

• Connect to the scales via the store network (using TCP/IP) 

• Displays the operation status of each scale. This includes: 
o Current scale operation mode 
o Error information 

• Displays the scale error log (number of times each type of error detected by scale) 

• Backup and restore of scale data 

• Backup and updating of the scale firmware 

• Generate logs recording scale activity 

• Display and update scale remote diagnostic and configuration data 

The aim of this software is to provide the system administrator at the store with a PC-based tool 
for monitoring and managing the Ishida scales connected to the store LAN. This includes 

acking up scale data and performing firmware updates. b
 

How to Use This Manual 
 

If you are about to install i-View. 
 

 See Chapter 2  Installation 

If you are a new user wishing to familiarize 
yourself with the software. 
 

 See Chapter 3  Getting Started 

If you wish to learn how to use a specific 
feature. 
 

 Lookup the feature in the Contents and 
find the relevant chapter. 
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2. Installation 

2.1 System Requirements 
i-View requires a Windows 98 or higher personal computer with a LAN connection. The 
software should also run successfully on Windows 95, but this has not been confirmed. 

A screen resolution of at least 800x600 is recommended. 

A floppy disk or CD-ROM is recommended for installation. 

Operation on Windows XP has been verified for i-View version 1.21. 

2.2 Installing i-View 
1. Startup Windows, then run SETUP.EXE from the installation floppy disk or CD-ROM. 

Follow the instructions that appear on the screen. 

2. The installation installs an icon on the desktop and a shortcut in the Windows Start 
menu. To run i-View, double click on the i-View icon or select Start → Programs → 
Ishida → i-View. 

3. Refer to section 3.1 Configuring i-View for details on how to configure i-View for your 
store. 

2.3 Uninstalling i-View 
Select Start → Settings  → Control Panel to open Control panel, then double click on 
Add/Remove Programs. Follow the instructions to remove i-View from your hard disk. 
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2.4 Dealer Mode 
To be able to access the various advanced setup commands in the Setup menu, i-View must 
be run in dealer mode, which is specified by the -d command line switch. This is set 
automatically if you install using the dealer mode installation. To set the command line switch 
manually, right-click on the shortcut you use to start i-View from the desktop or Windows Start 
menu, then open the Properties dialog. Add -d after the i-View  EXE file name. 

For example, if i-View  is installed in the C:\Program Files\Ishida\i-View folder, the command line 
should now read: 

 "C:\Program Files\Ishida\i-View\i-View.exe -d" 
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3. Getting Started 
This section provides a brief overview of the i-View software for users running the software for 
the first time. 

If you have just installed i-View and need to configure the software for your store, read section 
3.1 Configuring i-View below. 

If i-View has already been configured, proceed directly to section 3.2 Using i-View. 

3.1 Configuring i-View 
This section describes how to configure i-View for your store. However, if you have an existing, 
configured copy of the Ishida ScaleLink Pro or i-Label software packages already installed on 
your PC, you can load the LAN configuration (IP addresses of each scale, etc.) from the setup 
files of these packages. The operation is described below. 

If you do not have an existing Ishida software package, proceed to 3.1.2 Configuring the Scale 
Network. 

3.1.1 Copy Configuration from Other Ishida Software 
1. Run ScaleLink Pro or i-Label and select Save Site Setup from the Setup menu. 

Specify a file name and save the setup information. 

2. Start i-View and select Load Setup from the Setup menu. Select the file you saved in 
step 1 and click the Open button. 

3. This loads the scale LAN configuration (IP addresses of each scale, etc.). In i-View, 
select Scale Comms from the Setup menu and check that all scales have been 
configured correctly. If there are any problems, refer to 3.1.2 Configuring the Scale 

rk below. 

Note that i-View only supports AstraXT/AC-4000 series scales. Any 3000-series 

4. 

 

Netwo
or older equipment on your network will not have been loaded into the i-View 
setup. 
 

This completes configuration of the scale network parameters. Proceed to 3.1.3 Error 
Definitions and 3.1.4 Event Log Setup. 
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3.1.2 Configuring the Scale Network 
Use the following procedure to configure i-View for your store. 

1. Start i-View and select Scale Comms from the Setup menu. 

2. This opens the following Communication Links dialog listing the available scales. If you 
have just installed i-View, this list will be empty. 

 

 
3. Click the Add button to add a communication link. This displays a dialog like that 

shown below. (The format may change as new models are added.) Select the scale 
type, then enter the IP address of the scale. 

 

 
4. Click OK. This displays a dialog like the one below. Set any parameters that need 

changing, then click the OK button to save the settings. Repeat this procedure for 
each scale on your network. 
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The meanings of each field in this dialog are as follows: 

Link Name: Enter a name to identify the scale in the i-View screens. Defaults to the scale IP 
address. 

Scale 
Type: 

Specifies the scale model. 

Enable 
Link: 

Specifies whether to enable these network settings. Set this off if you wish to 
save network settings for a scale that is not currently connected to the network. 

Comms 
Log ON: 

Set this on to save a log of data transfer between the PC and scale. If you set 
logging on, specify the name of a text file in which to save the log. Use the 
Change File button if you wish to change the currently selected file. 
Saving a communications log provides useful information for troubleshooting 
scale problems. It is recommended that logging be set on. 

Port No: The TCP/IP socket port number for communications with the scale. This is 
currently fixed at 50021 for the AstraXT, 50031 for the AC-4000XT, 4031 for the 
AC-4000, and 6051 for the SR-2000, 5041 for the WM-4000, and 7061 for the 
BC-4000. 

IP 
Address: 

The IP address for the scale. An IP address is typically assigned to the scale 
when the scale is installed. Refer to the scale Service Manual for details on how 
to set the IP address on the scale. 

Connection 
Timeout 

Specifies how long i-View waits for a scale to respond when making the initial 
connection to a scale. The recommended value is 10 seconds. 
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3.1.4 Event Log Setup 
Select Event Log from the Setup menu to display the following dialog. 

 

 
The meanings of each field in this dialog are as follows: 

Enable 
Event Log: 

Specifies whether or not to save an event log. 

Keep Log 
for: 

Specifies how long to save the event log. If zero is specified, the event log is 
cleared each time i-View starts. Up to 365. 

Event Log 
File: 

Use the Select button to specify the file in which to save the event log. 
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3.2 Using i-View 
If i-View is correctly configured, a screen similar to that shown below should appear after you 
start the program. 

 

 
 

 

The table below gives a general overview of the main opera
operation of each screen is described later in this manual. 

Tab Bar Click on the tab bar buttons to display the differ

Scale List Each i-View screen lists the scales configured i
displayed in list format (as shown above) or as 
View commands in the View menu to switch be
cases, the scale icon indicates the current scal
Status column in list view mode). 

Operation 
Buttons 

Some i-View screens have buttons for performi
cases, the operation is performed for the scale 
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Operation buttons
tions for using i-View. The detailed 

ent i-View screens 

n the system. The scales may be 
icons. Use the Icon View and List 
tween display modes. In both 
e status (which is also listed in the 

ng specific operations. In most 
currently selected in the scale list. 
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4. Scale Status 
The following screen appears when you start i-View. 

 

 

4.1 Meaning of Scale Data 
This screen displays the current status of each scale in the network. The meaning of each 
column is as follows. 

 1. The displayed scale status is valid for the time when i-View last accessed the scale. 
See 4.2.1 Refreshing the Displayed Data for details of how i-View refreshes the 
displayed scale information. 

 2. The SR-2000 and WM-4000 does not support error data or detailed status 
information. The error fields remain blank for SR-2000 and WM-4000 scales. 

 

Scale Displays the scale name specified in the i-View setup. (See 3.1.2 Configuring the 
Scale Network) 

ID Displays the scale link number. This number is used within i-View only to identify 
the scale. 

Status Displays the current operation status of the scale. The meaning of each status is 
as follows. 

 

1 Normal Mode The scale is turned on, connected to the network, and ready for 
use. 

2 Busy Indicates that the scale was in use (calling up a PLU, weighing 
or printing a label) when i-View last refreshed the scale 
information. 

3 Not Connected The scale does not respond to communication via the network. 
Typically, this means the scale is turned off or disconnected 
from the network. 
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4 Registration 

Mode 
Indicates that the scale has been set to registration mode (P) 
by manual operation at the scale. (By pressing 9000 followed 
by the MODE key on the scale’s keyboard.) 

5 Setup Mode Indicates that the scale has been set to setup mode (B) by 
manual operation at the scale. (By pressing 6000 followed by 
the MODE key on the scale’s keyboard.) 

6 Subtraction 
Mode 

Indicates that the scale has been set to setup mode (D) by 
manual operation at the scale. (By pressing 7000 followed by 
the MODE key on the scale’s keyboard.) 

7 Total Mode Indicates that the scale has been set to total mode (F) by 
manual operation at the scale. (By pressing 8000 followed by 
the MODE key on the scale’s keyboard.) 

8 Sub-Total 
Mode 

Indicates that the scale has been set to sub-total mode by 
manual operation at the scale. (Activated by a preset key on the 
scale’s keyboard.) 

9 Test Mode Indicates that the scale has been set to test mode (C) by 
manual operation at the scale. (By pressing the RESET key + 
any other key on the scale’s keyboard.) 

 

# Errors Displays the total number of errors logged in the scale error log screen. 

Last 
Error 

Displays the date of the most recent error reported from the scale. 

Error Displays the most recent error reported from the scale. A detailed list of scale 
errors is shown in the error log screen. 
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The scale icon also changes depending on the mode, as follows (other icons may be added in 
the future for new scale models): 

Icon Modes 

 
AstraXT/SR-2000 : Normal mode, Busy 

 
AstraXT/SR-2000 : Not connected 

 
AstraXT/SR-2000 : Disabled 

 
AstraXT : Registration ~ Test mode 

 
AstraXT : Print head faulty 

 
AC-4000 : Normal mode, Busy 

 
AC-4000 : Not connected 

 
AC-4000 : Disabled 

 
AC-4000 : Registration ~ Test mode 

 
AC-4000 : Print head faulty 
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4.2 Scale Screen Operation 
The following operations are available from the scale screen. 

4.2.1 Refreshing the Displayed Data 
The following fields at the bottom of the screen control how i-View refreshes the displayed scale 
data. 

 
If “Auto-refresh status every ...” is set ON, the scale status is automatically refreshed at the 
specified interval. Click on the up and down arrows if you wish to modify the refresh interval. 
The interval can be up to 600 seconds. The other parameters, however, are only refreshed 
when i-View starts or when you click the Refresh button. 

Clicking the Refresh button updates all displayed information, regardless of whether auto-
refreshing is on or off. 

4.2.2 Show Status Log 
Click the Show Status Log button at the bottom right of the screen to open a dialog showing a 
log of scale status changes for the scale currently selected in the list. An example is shown 
below. 
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The meaning of each column is as follows. 

Date/Time The date and time at which the status change occurred. 

Duration The time since the previous status change. That is, the length of time the scale 
remained in the “Old Status”. 

Old Status The scale status prior to the status change. 

New 
Status 

The scale status after the status change. 

Click the Refresh button to refresh the display with any status changes since the dialog was 
opened. 

Click the Export button to output the log of status changes to a text file. 

Click the Clear Log button to clear the entire log. 

The figure below shows a sample output. 

 
                      Scale Status Log 
 
2001/07/18 14:00  Normal Mode -> Setup Mode   Duration 
(HH:MM:SS) = 00:00:24 
2001/07/18 13:59  Total Mode -> Normal Mode   Duration 
(HH:MM:SS) = 00:00:13 
2001/07/18 13:59  Normal Mode -> Total Mode   Duration 
(HH:MM:SS) = 02:05:44 
2001/07/18 11:53  Start i-View -> Normal Mode  
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4.2.3 Remote Diagnostics 
Click the Remote Diagnostics button at the bottom right of the screen to retrieve the thermal 
head data and other diagnostic information from the scale currently selected in the list. If 
successful, a dialog opens displaying the retrieved data. 

If i-View is unable to retrieve the remote diagnostics data, an error message appears describing 
the problem and the remote diagnostics dialog does not appear. 

The figure below shows an example of the data for an AC-4000. If necessary, you can edit the 
print head and label settings and send these back to one or more scales. To edit the data, 
select the [Edit Data] check box. 

 Remote diagnostics is not supported for SR-2000 and WM-4000 scales. 

 

 

 

If the scale supports the function to retrieve faulty head dot data, and if faulty dots are present 
on the print head, a graphic showing the location of the faulty dots appears at the bottom of the 
dialog, together with a list of faulty dot positions. 
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The meaning of each field is as follows. 

Scale The ID and name of the scale from which the diagnostic data was retrieved. 

Model The scale model (AstraXT or AC-4000) 

Program 
Version 

The version of the program running on the scale 

Memory Size The total amount of memory on the scale (in kilobytes) 

Free Memory The amount of memory currently available (in kilobytes) 

Head 
Resistance 

The head resistance value (0 to 999) 

Print 
Distance 

The print head usage expressed as a distance (km). 

Print Density A number (1 to 9) representing the print density (1 = light, 9 = dark). The 
default is 5. 

Label Sensor 
Check 

Displays the value of the label sensor when the scale data was last refreshed 

Label Length Label length + inter-label gap. The maximum label length is 242.5mm for the 
AC-4000 and 175mm for the AstraXT. 

Label Sensor 
Distance 

0 to 99.9mm 

No. of burned 
out head 
dots 

0 indicates that all head dots are OK, 1 to 448 indicates the number of burned 
out head dots. This is not available for AstraXT series scales. 

 

Operations 

The operation of each dialog button is as follows. 

Send to 
Scale 

Click this button to send the displayed data to one or more scales. The button 
only becomes enabled when the [Edit Data] check box is selected. 

Dump to File Saves the remote diagnostic data in a text file. You can use this to printout a 
hardcopy. 

Refresh Refreshes the displayed data by reading from the scale. 

Close Closes the dialog. 
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4.2.4 Scale Configuration Data 
The scale configuration function reads the configuration data from the currently selected scale 
and displays on the screen. This feature is not available on some AstraXT scales. 

The scale configuration function is password protected. Clicking the Scale Config Data button 
at the bottom right of the main screen opens a password dialog. After you enter the password, i-
View reads the data from the scale and opens a dialog similar to the one shown below. 

 The SR-2000 and WM-4000 does not support configuration data maintenance. 

 

 

 

The meaning of each tab is as follows. 

ROM Switch Settings All the ROM Switches that have been set up in the ROM Switch 
Fields dialog should be listed here, with their respective value 
read from the scale. If there are too many to fit on one screen, 
they may be split over two tabs. 

Setup Mode Settings #1 Lists some of the setup mode settings and their values 

Setup Mode Settings #2 Lists the remainder of the setup mode settings and their values 

Registration Mode 
Settings (B09) 

Lists the registration mode (B09-Pxx) settings and their values 

PLU File Selection (B08) Lists the PLU File Selection (B08-xx) settings and their values 

TCP/IP Settings Lists the TCP/IP related settings and their values. These values 
cannot be changed by i-View. 

Misc. Settings Displays various test mode settings including the AC-4000 model 
number and daylight saving time setings. 
This page only appears for AC-4000 scales. 

Cassette Settings Lists the label format and related settings for each cassette. 
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Operations 

The operation of the controls on each page is as follows. 

Edit Data Selecting Edit Data allows you to edit the data in each of the 
fields on the current page. However, fields that are not applicable 
to your model of scale remain disabled. Changes are not sent to 
the scale unless you click Send to scale. 

Load Data Loads the configuration data from a configuration data file. This 
loads a complete set of configuration data, not just the data on the 
current page. Changes are not sent to the scale unless you press 
Send to scale 

Save Data Saves the configuration data to a configuration data file for backup 
purposes. This saves a complete set of configuration data, not just 
the data on the current page. 

Reset Values This button resets all configuration data back to the original values 
loaded from the scale or configuration file. Any changes you have 
made are overwritten. 

Send to Scale Sends the updated configuration data to selected scales. This 
sends a complete set of configuration data, not just the data in the 
current page. 

Note: After sending settings to the scale, always reset the scale to 
ensure that the new settings are updated on the scale. To prevent 
misoperation, some scale setings are not updated immediately. 

Dump to File Outputs are hard copy of the configuration data to a text file. 
Clicking Dump to File opens a Save dialog to specify the file 
name. 

Close Closes the dialog. Any changes that have not been sent to the 
scale or saved in a file are discarded. 
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4.2.5 Export Status Information 
Select Export from the File menu to save the above status information for each scale to a text 
file. 

The figure below shows a sample output. 

 
                         Scale Status 
 
Scale : Bakery #1 (ID=1) : Status = Normal Mode 
Memory Size = 949KB,  Free Memory = 863KB 
Print Head Dist. = 0.000km,  Prog. Version = AG001C-A 
 
Scale : Bakery #2 (ID=2) : Status = Not Connected 
Memory Size = 0KB,  Free Memory = 0KB 
Print Head Dist. = 0.000km,  Prog. Version =  
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5. Error Log 
Clicking the Error Log tab displays the following screen. The right side of the screen displays a 
list of the errors logged by the scale selected on the left. 

 The SR-2000 and WM-4000 does not support the error log function. 

 

 
 

 

5.1 Displayed Error Information 
The meaning of each column is as follows. 

Error No. The scale error code. 

Description A brief description of the error. The description for each error code is specified 
as part of the i-View setup. See 3.1.3 Error Definitions for details. 

# Errors The number of times the error has been detected by the scale since the last 
time the error totals were cleared on the scale. 

Last Error The date of the most recent instance of the error. 

Click on Clear Error Log… to clear the contents of the error log on i-View and on the scale. 

5.2 Export Error Log 
Select Export from the File menu to save the above error log information for the selected scale 
to a text file. 

The figure below shows a sample output. 
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                         Scale Error Log 
Scale:Bakery #2 (ID=2) 
 
Error No.   Description                     # Errors  Last Error 
02          Commodity name is too long      06        2001/07/06 
04          Extra message 1 is too long     12        2001/07/06 
08          Out of labels/Label feed error  24        2001/07/06 
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6. Backup & Restore 
Clicking the Backup & Restore tab displays the following screen. The right side of the screen 
displays backup and restore information for the scale selected on the left. 

 

 

6.1 Backup & Restore Data 
Backing up the scale using i-View reads the following data from the scale as saves in a backup 
file (*.abk). The actual data depends on the scale model. 

PLUs Campaigns  
Store Name/Address Operator Name 
Extra Messages Batch Label Printing Data 
Free Messages Nutrition (if scale supports nutrition) 
Coupon Message PLU Production Data 
Preset Keys Hourly Production Data 
Scrolling Messages Operator Production Data 
Label Formats Operator Production Data (Unit Price Overwrite) 
Logo(Image) Data Thermal Head Configuration 
Field Titles Error Log 
 Scale Configuration 

 

6.2 Backing Up a Scale 
Use the following procedure to backup a scale 

1. Select the scale from the icons on the left side of the screen. This displays details of the 
most recent backup for that scale on the right side of the screen.  

2. Click the Backup Scale button. This opens a file Save As dialog to specify the file in 
which to save the scale data. Select a file and click the Save button. 
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3. i-View starts receiving data from the scale. A dialog appears displaying the progress of 
data transfer. The transfer may take some time, depending on the volume of data on the 
scale. A confirmation message appears when data transfer finishes and a summary of 
the received data is displayed. This completes the backup. 

If any error occurs during communications with the scale, an error message will appear 
describing the problem. In this case the backup will not be performed. 

  

Click the View Summary button if you wish to view a summary of the contents of the most 
recent backup. 

 

6.2 Restoring Data to a Scale 
Use the following procedure to restore data to a scale 

1. Select the scale from the icons on the left side of the screen. The Backup File field at 
the bottom right of the screen displays the currently selected backup file (typically, the 
most recent backup for that scale). 
Click the Select button if you wish to select a different file to restore to the scale. 

Click the View Summary button if you wish to view a summary of the backup file 
contents. 

Click the Clear RAM & Setup on Scale button if you wish to clear the scale before 
restoring the data. 

 

2. Click the Restore Scale button. This opens the following dialog for specifying which 
data to copy back to the scale. Unsupported data types are greyed out. 
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3. Click on one of the Restore Mode buttons to specify the type of restore to perform. The 
options are: 

Standard restore or scale-to-scale copy 
Use this option when you wish to restore the PLU and other scale operational data 
only. This only restores the data types indicated by a check mark in the lower half of 
the screen. This option omits data that is time-dependent (such as production data 
which would be out of date) or specific to an individual scale (such as the thermal 
head configuration). 

Special full restore 
Use this option if you wish to restore all data to the scale. This option is typically used 
to restore a scale that has lost all its data due to a fault or other reason. For example, 
if the main circuit board has been replaced. 

Custom 
Use this option if you wish to specify yourself which data to restore. In this case, select 
the restore data using the check boxes in the lower half of the dialog. 

4. Click the OK button to start data transfer to the scale. A dialog appears displaying the 
progress of data transfer. The transfer may take some time, depending on the volume of 
data to be sent. A confirmation message appears when data transfer finishes. This 
completes restoration of scale data. 

If any error occurs during communications with the scale (if the scale is not in “Normal 
Mode”, for example), an error message will appear describing the problem. In this case 
the scale data will not be restored. 
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7. Scale Program Update 
Clicking the Scale Program Update tab displays the following screen. The right side of the 
screen displays the program version information (Current Program ID) for the scale selected 
on the left. 

 The SR-2000 and WM-4000 does not support scale program updating. 

 

 
 

 
 When updating the program on the scale, it is very important that the correct 

program file is sent to the scale. Sending an incorrect file to the scale may cause 
the scale to malfunction. This will make the program update function unavailable 
and therefore you will be unable to use i-View to send the correct file. Be very 
careful when updating the scale program. 

 

7.1 Get Program from Scale 
Use the following procedure to backup the scale application program. The received program will 
be in binary format. 

1. Select the scale on the left side of the screen. This displays the scale name and current 
program ID at the top right of the screen. 

 

2. Click the Get Prog. from Scale button. This opens a file Save As dialog to specify the 
file in which to save the scale program. Select a file and click the Save button. 

3. i-View starts receiving the program from the scale. A dialog appears displaying the 
progress of data transfer. A confirmation message appears when data transfer finishes. 
This completes backing up of the scale program. 

If any error occurs during communications with the scale (if the scale is not in “Normal 
Mode”, for example), an error message will appear describing the problem. In this case 
the program backup will not be performed. 
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7.2 Update Program on a Single Scale 
Use the following procedure to update the application on a specified scale. Typically, the 
updated program file will have been provided by your Ishida dealer. Take great care to send the 
correct file to the scale as an incorrect file may cause the scale to malfunction. 

1. Select the scale on the left side of the screen. This displays the scale name and current 
program ID at the top right of the screen. 
 

2. Click the Update Prog. on Scale button. This opens a File Open dialog to specify the 
new program file to update on the scale. Two different file formats are supported. 

 

Motorola 
format (*.MOT) 

Motorola format was used to distributing scale application files 
in the past. i-View converts Motorola files to binary format 
internally before sending to the scales. 

Binary (*.BIN) Scale application files are typically provided in binary format. 
Also, programs received from the scale using Get Prog. from 
Scale are in this format.. 

 

3. Select the correct file and click the Open button. The following confirmation dialog 
appears. 

 
4. If everything is OK, click the OK button to start sending the program to the scale. 

A dialog appears displaying the progress of data transfer. A confirmation message 
appears when data transfer finishes. This completes updating of the scale program. 

If any error occurs during communications with the scale (if the scale is not in “Normal 
Mode”, for example), an error message will appear describing the problem. In this case 
the program will not be updated on the scale. 

5. Typically, the scale will reset automatically after receiving the new program, but some 
older versions of the scale firmware require that you reset the scale manually before the 
new program takes effect. 

i-View waits for approximately 30 seconds after sending the program completes to allow 
the scale to reset, then refreshes the scale data via the comms link. The new program 
version number should appear in the Prog. Version column on the left side of the 
screen and a service journal entry is generated automatically to record the program 
update. 
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7.3 Update Program on All Scales 
This updates the application on all currently connected scales. The operation is the same as 
described in 7.2 Update Program on a Single Scale above except that you use the Update 
Prog on All Scales button. 

 When updating the program file on all scales, it is very important to check that the 
program you are sending is correct for all scales. Sending an incorrect file to a 
scale may cause the scale to malfunction. This will make the program update 
function unavailable and therefore you will be unable to use i-View to send the 
correct file. Be very careful when updating the scale program. 

 

An error message appears if communications with any scale is unsuccessful. In this case, the 
program is not updated on that scale (but is updated on all other scales). 
After performing a program update for all scales, i-View waits for approximately 30 seconds to 
allow the scale to reset, then refreshes the scale data via the comms link. The new program 
version number should appear in the Prog. Version column on the left side of the screen and a 
service journal entry is generated automatically for each scale to record the program update. 
Check that the program version IDs for each scale have been updated correctly. 
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8. Service Journal 
The purpose of the service journal is to record the service history for each scale. 

Typically, the service person will use i-View to enter details of any service visits to each scale. 

i-View also generates service journal entries automatically to record whenever a new firmware 
program is sent to the scale using the Scale Program Update function. 

 
The procedure for using the service journal is as follows: 

1. Select the scale on the left side of the screen. This displays the service journal for that 
scale on the right of the screen. 
 

2. Click the Add Journal Entry button to add a new journal entry. This opens the dialog 
shown below for you to enter the details of the service visit. 
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3. If you wish to make a copy of the journal entry, click the Export Journal button at the 
bottom right of the screen to display the following dialog. 
This provides a range of options for outputting the service journal to a file. 

Select the desired options, then click OK. 

i-View asks whether you wish to view the resulting file in Windows Notepad. If you need 
to printout the file, click Yes, then select Print from the File menu in Notepad. 
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9. Event Log 
The event log records a list of all significant events that occur in the i-View program. This 
includes the following: 
• Scale status changes (e.g. Normal <-> Setup mode) 
• Backup and restore operations 
• Program backup and update operations 

The event log can be turned on or off and the length of time log data is maintained can be 
specified. See section 3.1.4 Event Log Setup for details. 

To view the event log, select View Event Log from the View menu. This runs Windows 
Notepad and opens the event log file. Use Notepad to view or printout the log. 

The figure below shows a sample output. 

 
2001/07/18 11:26:31|G Starting i-View 
2001/07/18 11:52:56|G Loaded setup file D:\Dev\Slp3\Slp3Test.sit 
2001/07/18 11:53:57|S Scale "Bakery #1" (ID=1) : Status change Start 
i-View -> Normal Mode 
2001/07/18 11:53:57|S Scale "Bakery #2" (ID=2) : Status change Start 
i-View -> Not Connected 
2001/07/18 15:34:23|B Backed up scale "Bakery #1" (ID=1) to file: 
C:\Program Files\Ishida\i-View\BakeryBackup.abk 
2001/07/18 15:52:45|B Backed up scale "Bakery #1" (ID=1) to file: 
C:\Program Files\Ishida\i-View\BakeryBackup.abk 
2001/07/18 15:58:53|S Scale "Bakery #1" (ID=1) : Status change 
Normal Mode -> Busy 
2001/07/18 16:18:12|B Restored backup to scale "Bakery #1" (ID=1) 
from file: C:\Program Files\Ishida\i-View\BakeryBackup.abk 
2001/07/18 16:18:13|S Scale "Bakery #1" (ID=1) : Status change Busy 
-> Normal Mode 
2001/07/18 20:37:09|B Read program from scale "Bakery #1" (ID=1) and 
saved in file: C:\Program Files\Ishida\i-View\IVPROG1.BIN 
2001/07/18 20:53:39|B Updated program on scale "Bakery #1" (ID=1) 
from file: C:\Program Files\Ishida\i-View\IVPROG1.BIN 
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10. i-View Setup 
i-View has a number of setup data items that modify operation to suit the particular models of 
scale you are using. Typically, the i-View installation will install the correct setup for your site. 
Alternatively, you may select Load Setup from the Setup menu to load the settings from a file 
supplied by Ishida. 
The following sections describe the setup information in detail. however, normal users should 
not need to modify the settings themselves. 

  
The main setup functions are only available if i-View is run in dealer mode. See 2.4 
Dealer Mode for details. 

 
 

10.1 Event Log Setup 
See section 3.1.4 Event Log Setup in 3. Getting Started. 

10.2 Error Definitions 
The scale error log stores errors as two-digit codes. The error definitions specify the meaning of 
each scale error code.  

To edit the error definitions, select Error Definitions from the Setup menu to display the 
following dialog. A password is required to access this dialog. 

Use the Add, Edit, or Delete button to edit the definitions. 

 

 

10.3 Configuration Data Setup 
This specifies the meaning of the scale-specific data contained in the AC-4000 scale 
configuration. 

To edit the setup, select Configuration Data Setup from the Setup menu to display the 
following dialog. A password is required to access this dialog. 
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The meanings of each field in this dialog are as follows: 

Country Select your country from this drop-down list for region-specific settings. 

Use 
Nutrition 

Select this if you use nutrition information. 

Unit 
Types 

This is the list of currently defined unit types and their values. 

Bar 
Code 
Types 

This is the list of currently defined Bar Code types and their values. 

Pos 
Code 
Types 

This is the list of currently defined Pos Code types and their values. 

Bar 
Code ITF 
Types 

This is the list of currently defined Bar Code ITF types and their values. 

 

The operation of each of the code type boxes is the same. Click Add, Edit or Delete to edit the 
definitions. If you are adding a new  type, you will need to specify a name and a value for the 
type. 

Click OK to close this dialog and save any changes. 
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10.4 ROM Switch Fields 
The scale configuration data includes a set of 64 “ROM switches” which control scale operation. 
The meaning of each ROM switch varies between scale models and countries. The ROM switch 
fields setup is used to define the meaning of each ROM switch. 

To edit the field definitions, select ROM Switch Fields from the Setup menu to display the 
following dialog. A password is required to access this dialog. 

 
Click on Add, Edit or Delete to edit the fields. When you click on Add or Edit, a dialog similar to 
the one below appears. 
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The meanings of each field in this dialog are as follows: 

Name The name of the ROM Switch field 

Field 
Type 

The ROM Switch Type, from “ROM Switch 0” to “ROM Switch 63” 

Display? Select this if you want the field to be displayed on the ROM Switch Settings screen 

Display 
Width 

The number of digits that should be displayed. Must be at least 1. 

Digits 
after Dec. 
Pt. 

The number of digits after the decimal point 

Display 
in Hex 
Format? 

Determines whether the value is displayed in Hexadecimal on the ROM Switch 
Settings screen 

Maximum Select the maximum value that should be allowed to be input. 

Minimum Select the minimum value that should be allowed to be input. 

Default 
Value 

Select the default value for this ROM Switch. 

Field 
Values 

These values are preset values that can be selected for the ROM Switch. Click 
Add, Edit or Delete to edit this list. If there are values in this list then these values 
are the only ones which will be available on the ROM Switch Settings screen. If 
this list is empty then any value can be entered. 

Click on OK to save changes to the field, or Cancel to cancel any changes. Then click OK on 
the “Field Definitions” dialog to save changes to the field definitions list. 
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